Lara Stables

Visual Arts, Art II


Lesson Plan
Introduction
· Lesson Topic: Watercolor Image Manipulation
· Length of Lesson: 90 minutes
· Virginia Standards of Learning: 

· AII.1 The student will expand the use of sketchbook/journal by adding preliminary sketches, finished drawings, critical writings, and class notes.
· AII.4 The student will use technology to create and manipulate images

· AII.20 The student will describe, analyze, interpret, and judge works of art, using an expanded art vocabulary.

· Context: This lesson plan is intended for an Art II class. This lesson is the third class block in a five block unit on watercolor. In this lesson students will be quizzed on information about watercolor techniques, materials, and history. The students will also be introduced to their final watercolor project.
· Global Themes: As, Art I is offered to students in the eighth grade, many ninth grade students will come into high school and take an Art II course. Students, while having already been exposed to other forms of painting medium in previous art classes, need the exposure to watercolor in order to expand their continued learning of art media. This unit could be considered the painting unit for students, but it is likely that an acrylic painting will still be done later in the year. 

Content Objectives
· The student will classify, distinguish, and discuss prior knowledge in a quiz on watercolor vocabulary, history, and techniques.
· The student will experiment with Photoshop to manipulate an image that contains a historical piece of architecture.
· The student will create a sketch, in the form of a cartoon that shows the main details of their manipulated image.
Assessment Aligned to Objectives
Formative:
· The teacher will check student understanding of the watercolor terminology and techniques through the use of the quiz. 
· The teacher will also be checking herself to make sure that quiz questions have been understood by the students.
· The teacher will assess student’s abilities to follow directions based upon their ability to execute the image manipulations using Photoshop.
· The teacher will roam the classroom as students work in Photoshop to answer student questions.
· The teacher will give approval to students who finish their image manipulations, allowing them to begin sketching a cartoon in their sketchbooks
Summative:

· The students will complete a quiz based on their knowledge of watercolor materials, techniques, and historical watercolorists learned.

· The students will, in their final two class blocks of the watercolor unit complete a watercolor painting that depicts an architectural building during one of the three times of day: morning, afternoon, or evening.
Materials/Technology and Advanced Preparation
Materials/Technology:
· Watercolor Quiz
· Tube Watercolors
· Cake Watercolors
· Watercolor paper, 5x7
· Computer
· Projector
· SmartBoard or pull down screen
· Computer Lab or Student Computers with Photoshop capabilities
· Final watercolor Painting Rubric
· Advanced Preparation: The teacher will have cut 5x7 pieces of watercolor paper for the anticipatory set assignment. The teacher will have set out watercolor paints (cake and tube), as well as watercolor brushes for the class. The teacher will have copied a set of quizzes for the entire class. The teacher will have signed up to use a computer lab or made sure that all student computers have Photoshop capabilities. The teacher will lastly make sure to set up the PowerPoint before the class starts by turning on the computer, projector, and SmartBoard if necessary to be used at the end of class.
Teaching and Learning Sequence

	TIME
	TEACHER ACTIONS
	STUDENT ACTIONS

	Introduction/Anticipatory Set – Outline how the lesson will begin. How will you focus student attention on lesson content, build on prior knowledge, motivate students to learn, etc.?

	2 minutes
8 minutes
	The teacher will instruct the students on an introductory watercolor painting exercise. (see lesson organizer for directions)

The teacher will go over the quiz directions with those students who need extra in class time to complete it and then instruct them that they may begin the quiz.

	The students, after the teacher finishes talking will gather materials necessary for the assignment.
The students will work on their introductory assignment or they will be listening to teacher directions for the quiz.


	Lesson Development – Outline the sequence to be followed in the development of the lesson. Pay particular attention to concept development and questioning. 

	5 minutes
25 minutes

2 minutes

5 minutes

33 minutes
	The teacher hands out the watercolor quiz and goes over directions for each section of the quiz. 
The teacher roams the classroom, when needed. The teacher answers student questions when called upon.

The teacher take the class to a computer lab or if possible (and the county has a one to one initiative) the teacher would instruct students to have their computers ready to use for class, but to not yet turn them on.

The teacher instructs the students on their final watercolor painting assignment. (See lesson organizer for assignment and attached rubric for teacher expectations.)

The teacher roams the classroom or computer lab and answers student questions. When the teacher feels a student is ready, they have the student begin sketching their building for final approval.


	Students take a quiz and listen as teacher goes over instructions Students wait to begin the quiz until the teacher gives the okay.

The students work on the quiz and turn into the teacher when finished. If students have a question, they raise their hand.
The students wither travel to the computer lab or they pull out their school assigned laptops.
The students listen as the teacher goes over the in class assignment.

The students work with Photoshop to manipulate their chosen images. Then, if given the teacher go ahead; they can begin to sketch their final painting idea in their sketchbook.

	Closure – Outline how the lesson will be concluded.  How will you summarize, review, reinforce, enrich, and/or encourage students to reflect on what they have learned?

	10 minutes
	The teacher shows about a minute or so of the Khan Academy video and has students come up with a jot chart, in their sketchbooks to compare and contrast the differences between Monet’s paintings and watercolor paintings.  


	The students watch the video and complete their jot chart, in their sketchbooks after watching the video. 




Homework


Students should continue to sketch final project ideas in their sketchbooks, based upon work done in class. Two complete sketches for the final project will be due to the teacher at the beginning of the next class.
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Appended Materials

· Lesson Organizer

· Watercolor Techniques and History Quiz

· Answer Key to Watercolor Quiz
· Monet’s haystacks image thumbnails

· Watercolor Painting Rubric

· Khan Academy video (http://www.khanacademy.org/humanities/art-history/art-history-1848-1907-industrial-revolution-ii/v/monet--rouen-cathedral-series--1892-4 )

· Jot Chart Example

	Prior Knowledge and NEW Instructional Content

	Prior Knowledge: Students will use their prior knowledge from the previous two class blocks to help inform their choosing the right answers in their quiz. 
Chemical make-up of watercolor paint and the materials associated with the medium.

· Chemical Make-up of Watercolor paint:

· Crushed pigment (like French ultramarine or yellow oxide)

· Gum Arabic ( a water-soluble binding material)

· Three forms of Watercolor paint:

· Liquid

· Tube

· Cake

· Two types of Watercolor paper:

· Hot Press, which is smooth to the touch

· Cold Press, which is rough to the touch

· 140 pounds is a good weight for Watercolor paper

· Two types of brushes:

· Flat 

· Round

· Types of bristles in the brushes:

· Bristle (synthetic fibers)

· Sable (natural hairs), best for Watercolor

Famous Watercolorist throughout art history

· Albrecht Dürer (1471-1528)

· German artist during the period of the Northern Renaissance

· Used water-soluble paints on parchment or paper and overlaid transparent colors.

· Used the color of the paper for the lightest of lights.

· Was also know for his woodcuts, which he hand tinted.

· J.M.W. Turner (1775-1851)

· British artist during the period of English Romanticism

· Constantly experimented with ways of moving the paint around and with new pigments and papers

· Used color directly by working wet on wet, scrubbing off, sponging, and scratching out 

· His use of watercolor allowed the medium to be seen as a work of art in its own standing.

· Winslow Homer (1836-1910)

· American artist who was one of the first to use watercolor as more than a preparatory tool for study. He used it as a real painting medium.

· Worked during the period known as American Realism.

· Was the first artist to formally show a finished watercolor in a show.

· Would sometimes wipe a color to lighten it or would even scrape away paint with a knife. 

Watercolor Painting Techniques:

· Wash: thin layer of paint, usually applied with a brush that is heavily saturated with a lot of water.

· Graded Wash: the tone of color moves smoothly from dark to light, applying the darkest tone first and proceeding down, getting lighter and lighter.

· Blotting or Sponging: known also as “lifting off;” do this when the color is wet or after it has dried to lighten areas of the painting

· Splattering: just as it says, splattering paint on the paper. Best way to not get color everywhere is to load your brush with color, hold it over your paper, and gently tap the brush to allow the paint to “splatter”

· Dry-Brush: Going over a dry area of the painting with a new layer of color; used mainly when trying to do detail work or outlines

· Wet-on-Wet: Wet color on top of wet color, allows colors to bleed together when drying

· Tape or use of Masking Fluid: leaves areas of white for highlight purposes; if using masking fluid: you should first wet the brush and rub it on top of a bar of soap, then dip in the fluid. This allows for the brush to clean easier after use.

· Salt or Rubbing Alcohol: With wet color, drop some salt or rubbing alcohol on the paper to get a different kind of wet-on-wet reaction.

· Sgraffito or “scratching out”: getting the white of the paper back by gently scratching at the surface of the paper with a knife.

New Instructional Content: 
As a part of their anticipatory set, the students will experiment with different times of day in watercolor, using Monet’s haystack paintings as a model. The students will copy what they see depicted and each table will have a different time of day to look at. (see appended image thumbnails) The idea is for students to experiment with the effects light and shadow, while getting another opportunity to practice with watercolors before their final painting assignment.

For their in class assignment, in preparation for the final watercolor painting, students will manipulate an image using Photoshop to  change the time of day a picture appears to have been taken in. to change the time of day a student needs to: (source of instructions: http://www.ehow.com/how_7291997_make-look-like-night-photoshop.html )
· Open their image in Photoshop

· Click on the “lasso” tool on the left in their toolbar.

· Draw a “lasso” around the sky in their image. After this is done, blinking layers will appear and the student needs to right click on the blinking layer and select “layer via copy.”

· Click the "Image" menu at the top of the screen, click "Adjustments" and click "Levels."
· Drag the "Levels" window over to the side so you can see both it and the selected area of the picture. Slide the white triangle under the "Output Levels" section to the left, darkening the picture. The further to the left you slide, the darker the sky will appear. Click "OK" when satisfied.
· Click the "Window" menu and select "Layers" to open the Layers palette. Note two layers: Background and the sky layer, Layer 1.
· Click the Background layer and draw an outline around a person or object in the photo. Repeat the right-click and "Layer via Copy" process.
· Double-click the new layer in the Layers palette to open the "Layer Style" window. Click the "Drop Shadow" option under Styles, which places a check mark in the Drop Shadow box, gives your selected item a shadow and opens the Drop Shadow dialog.
· Slide the "Distance," "Spread" and "Size" slider bars to the right to increase the shadow's depth and thickness. Click "OK" when satisfied.
· Add additional shadows to objects in the picture by clicking the Background layer and repeating the "Lasso" and "Layer Style" process.
· Click the small lines icon in the Layers palette and select "Flatten Image." The layers will merge down into one. Click the "File" menu, click "Save As," type a new name for the picture and save it to the computer.
Once students have completed this process they will be allowed, with teacher approval, to begin sketching the image in their sketchbooks. The purpose of this is for the students to create a cartoon (a preliminary sketch or model) of the image to later be lightly drawn on the watercolor paper, before they begin painting. Students should be working in their sketchbooks the rest of the class block. 






	Instructional Modifications to 

ASSIST Students
	Main Events of Instruction
	Instructional Modifications to 

CHALLENGE Students

	· Students, who need this time for the quiz, can complete the painting exercise at another time.
· The teacher reads quiz questions out loud to students who need this.
· The teacher allows students with learning disabilities to have more time on their quiz, if needed.
· The teacher will give the student a print out of the Photoshop instructions.

· The teacher will give students a jot chart to place in their sketchbook.
	Anticipatory Set:
· Students will work on a watercolor painting exercise.
Lesson Development:

· Teacher goes over quiz directions

· Students take the quiz

· Teacher gives instructions on final watercolor painting

· Students use Photoshop to manipulate images.
· Students sketch cartoon of their image in their sketchbooks.
Closure: 

· Students watch the Khan Academy video

· Students fill out a jot chart
	· Students will have the opportunity to finish this exercise another time, if not finished after the ten minutes allotted.  
· The student will check to see that all directions are understood.

· The student can help others struggling with Photoshop directions.

· The student will have completed their cartoon and be asked to possibly add more detail to the image.

· The teacher will give students a jot chart to place in their sketchbook.


Name_________________

Date__________________
Watercolor Techniques and History Quiz
I. Matching: Choose the definition that describes the vocabulary word and place the letter in the blank space provided, next to the word. Use capitol letters. (2pts each)
_____ 1. Wet-on-Wet                         A. British watercolorist who used wet-on-wet, 





sponging, and sgraffito in his paintings.
_____ 2. Albrecht Dürer                     B. a water-soluble binding material
_____ 3. Dry-Brush                            C. wet color on top of wet color, allows colors to 





bleed together when drying
_____ 4. Gum Arabic


D. applying detail to an area of the painting that is 





already dry 
_____ 5. Sgraffito


E. German artist who used water-soluble paints to 





hand tint his finished woodcut prints.
_____ 6. J.M.W. Turner

F. scratching at the surface of the watercolor paper 





to pull out areas of white
II. Fill in the Blanks: Read each question carefully. Answer in the lines provided. (2pts each)
1. Give the three forms that watercolors are usually found in:

a. ___________________

b. ___________________

c. ___________________
2. List three watercolor techniques, not already mentioned in the matching section:

a. _____________________

b. _____________________

c. _____________________

3. Name two basic types of brushes normally used for painting with watercolors:
a. ____________________

b. ____________________

III. Short Answer: Read each question carefully. Answers must be in complete sentences. (4pts each)
1. What is the difference between hot and cold press watercolor paper?

2. What are the two types of bristles used in watercolor brushes? Which is the better of the two to be used with watercolor paints?
3. Who was Winslow Homer? What is his significance in the history of watercolor painting?

Watercolor Techniques and History Quiz: Key
I. Matching: Choose the definition that describes the vocabulary word and place the letter in the blank space provided, next to the word. Use capitol letters. (2pts each)

_____ 1. Wet-on-Wet                         A. British watercolorist who used wet-on-wet, 





sponging, and sgraffito in his paintings.

_____ 2. Albrecht Dürer                     B. a water-soluble binding material

_____ 3. Dry-Brush                            C. wet color on top of wet color, allows colors to 





bleed together when drying

_____ 4. Gum Arabic


D. applying detail to an area of the painting that is 





already dry 

_____ 5. Sgraffito


E. German artist who used water-soluble paints to 





hand tint his finished woodcut prints.

_____ 6. J.M.W. Turner

F. scratching at the surface of the watercolor paper 





to pull out areas of white

II. Fill in the Blanks: Read each question carefully. Answer in the lines provided. (2pts each)

4. Give the three forms that watercolors are usually found in:

a. ___________________

b. ___________________

c. ___________________

5. List three watercolor techniques, not already mentioned in the matching section:

a. _____________________

b. _____________________

c. _____________________

6. Name two basic types of brushes normally used for painting with watercolors:

a. ____________________

b. ____________________

III. Short Answer: Read each question carefully. Answers must be in complete sentences. (4pts each)

1. What is the difference between hot and cold press watercolor paper?

2. What are the two types of bristles used in watercolor brushes? Which is the better of the two to be used with watercolor paints?

3. Who was Winslow Homer? What is his significance in the history of watercolor painting?

Thumbnails of Monet’s Haystacks
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Final Watercolor Painting: Architecture at Different times of the Day

Directions: Using Photoshop you will manipulate an image containing a piece of historic architecture, approved by the teacher, to show a different time of day. You will then sketch the image into your sketchbook. Once a completed sketch has been approved by the teacher you may begin to sketch the design, lightly on watercolor paper before using paint. When the sketch has been completed you may begin to use the watercolor paints. You will have two class blocks to complete this assignment.

Rubric: You should have the following: 
· An image manipulated in Photoshop to show either night, dusk, early morning, midday, etc. [10pts]
· A completed sketch, approved by the teacher, of your image before beginning the painting. [10pts]

Your painting should contain the following:
· Historical piece of architecture (ex. Notre Dame, the Colosseum, the Lincoln Memorial, the National D-Day Memorial in Bedford, VA, etc.) [15pts]
· At least three of the watercolor techniques learned in this unit (ex. masking fluid, sgraffito, washes, wet-on-wet, etc.) [15pts]
· An understanding of the uses of the principles of design and elements of art [10pts]
· Contrasts in light and dark, showing use of shadows [10pts]
Example of possible Jot Chart:
	Monet’s Rouen Cathedral Paintings
	Watercolor Paintings
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